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Critical Improvements:

    - Watch Window loading of data has been sped up drastically
    - Hyperview stop CIUMon from fetching new data when it changes pages
    - CIUMon stops getting data that Hyperview says is no longer needed
    - CIUMon handles many timing and error conditions better
    - Go To Use feature has been created to make full screen navigation easy

Hyperview:

1.  Many Watch Window improvements and features have been implemented:
    a.  Data files for the Watch Window are now loaded in the background 
        when Hyperview is opened so as to not stall other operations.  
        For large datasets, you will see a progress bar on the block list
        to indicate that a load is underway; it will disappear once the 
        load is completed.
    b.  The ability to delete data for a block in the Watch Window is now
        supported.  Select the range of data you wish to delete and click 
        on the "Delete Data" button on the toolbar.
    c.  You can now quickly navigate to any timestamps that you may have
        created on the Watch Window.  You can use the buttons located at 
        the bottom of the Watch Window to go to the first, previous, next 
        or last timestamp and it will automatically center it in the window.  
        As well, if you scroll away from the currently selected timestamp 
        you can press the "Jump to selected timestamp" button to get you back.
    d.  The option to invert the axis has been added to the Watch Window.
    e.  The option to "Go To Source" and "Go To Block Map" has been added to
        Watch Window.  Right click on a block to bring up the context menu
        and select the option.

2.  With the implementation of the Watch Window, plots have been removed
    from live loop annotations.  Pre-existing live loop annotations with plots
    will be automatically converted into Watch Window plots on the initial
    start up of the new Hyperview.

3.  Support has been added to ask for the Module status and to display
    the data appropriately.  You can ask for this data by launching the
    "Define Live Loop Annotation" dialog, selecting the "Module Status"
    radio button and specifying the Loop, PCU and Module that you want
    the status of.

4.  Data points for live loop annotations and continuous monitoring are
    fetched at the start of their timer cycles so that a fresh value will
    be displayed if the user chooses to modify the update interval.

5.  Retrace Extension has implemented a "Go to Use" capability.

6.  The "/block" command line qualifier has been added.  The format for the
    switch is as follows:  /block="Module L,PP,MM Block BBBB".  Hyperview will
    call up the specified source block.

7.  Hyperview will now send a terminate_request command to CIUMon when live
    loop monitoring is on and it moves on to a different document.  This will
    allow CIUMon to discard any outstanding requests that it may have queued
    up and lessen the load to the CIU by not sending requests that are no
    longer valid.

8.  You can now use the 'M' key to turn on snapshot monitoring; 'Shift-M' will
    turn it off.  Pressing F5 in snapshot mode will refresh the data.

9.  Choose what document Hyperview will open to when it starts up by setting it
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    in "Options | View".  You can choose to have it open up to the last viewed
    page or the Home Page that you set by clicking on the appropriate radio
    button.

CIUMon:

1.  Demand Module Status command handling has been added.

2.  Better error recovery has been implemented for the following error codes:
    a.  31 - Checksum Compare Error
    b.  32 - Destination node offline
    c.  39 - Destination ring offline
    d.  40 - Destination node busy
    e.  41 - Destination ring busy
    f.  110 - Module not responding
    Error recovery in general has been improved.

3.  CIUMon has been modified to discard outstanding requests when it receives
    a "terminate_request" command from Hyperview.  It will not send obsolete
    requests to the CIU nor will it send any outstanding responses that it has
    back to Hyperview.

4.  A general cleanup of memory and resource leaks was done.

5.  When CIUMon is configured to run as a service and is not interacting with
    the desktop then it will autoconnect regardless of whether or not the 
    user has this set up in the configuration.

6.  A bug where the OPC90Server was not getting launched when configured to 
    in the options has been fixed.

7.  The timing of sending and receiving data has been improved.

8.  The display handling has been reworked and improved.

===================================================================

Previous Version:      DBDOC  -  Release Notes - Version 10.2   Date: February 11, 
2008

Hyperview:

1.  Many improvements and additions have been made to the Watch Window.
    a.  Autoscaling - the Watch Window will automatically scale the plot
        to fit the minimum and maximum values of the point/group.
    b.  Checkbox added to the block list  - if checked, the line associated
        to the block is shown; otherwise it is hidden
    c.  Clock icon added at both block and group level shows the current 
        live data gathering status.
          i. Green - Actively collecting data and is not stale
         ii. Red - Stale data
        iii. White - Data collection is paused.
        The state of the clock icon at group level can one color or a combination
        of colors to reflect the state of all the points in the given group.
    d.  Export data for points to a .CSV file.  You can also choose to check
        the "Excel" checkbox to have the .CSV file opened up in Excel
        automatically after the export has been completed.
    e.  Timestamps can now be deleted from the plot.  Click the [x] on the time
        label to delete it.
    f.  You can copy a block from one group to another.  Choose "Copy Block to
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        Group" from the context menu that appears on a right click.
    g.  View each block in its own separate plot in the Watch Window.  You can 
        toggle between a split or overlapped view of multiple plot plines.
    h.  A legend appears in the lower right-hand corner of the Watch Window 
        listing the block icons (show, pause, autoscale) and what they do.

2.  Stale data is now displayed correctly on ladder diagrams on rung function
    codes.  A red background rectangle is now drawn behind the point to indicate
    that it has gone stale while it shows the last known state in the box.

3.  Tooltips now appear on the block map to help explain the different types
    of blocks that appear.

4.  Fixed Y-coordinate display on graphics and CADs.

5.  The "Print Full Sheet" option now latches correctly so that the state is 
    retained between runs.

6.  The following changes have been made to the shortcut keys:
    a.  The "S" key now works the same as the "C" key for turning on/off Specs.
    b.  The keyboard shortcut for next and previous search hit has been removed.
    c.  The "Z" key now works as zoom toggle.
    d.  The "+" and "=" keys zoom in while the "-" and "_" keys zoom out on the
        current document.

7.  General performance improvements and fixed memory leaks.

CIUMon:

1.  You can now limit the usage of CIUMon to get live data by username (previously
    limited by IP Address only).  Enter in the usernames the CIUMon options
    and specify whether or not the user is allowed to fetch live data.  If a 
    user not allowed live data gathering then he will see the USER_BLOCKED 
    message in Hyperview or CIULink.

2.  New usage statistics are now being collected in CIUMon.  CIUMon will track
    the username and IP Address of all requestors and the first time that they
    tried connecting to CIUMon.  You can see how many users have been monitoring
    with the current instance of CIUMon and who is currently active.

3.  CIUMon can be run in "Relay Mode" where it relays requests between two other 
    instances of CIUMon.  This mode is used in situations where TCP/IP traffic
    is prohibited across more than one LAN.

4.  Incoming requests are now dequeued based on the weight of the user so that no
    one user can monopolize all of the bandwidth.  CIUMon will cycle through 
    all of users and dequeue the requests allocated to a particular user
    before moving on to the next.  This allows for the usage to be spread out
    among all requestors.

5.  CIUMon has been converted to Unicode to be compatable with foreign language
    platforms.

6.  INICT13A support has been added.

7.  The newest version CIUMon now runs at high priority.  If you wish to change
    the priority level of CIUMon then you can access the "Set CIUMon Priority..."
    option from the "Options" menu.

8.  A new feature has been added for those users who have TRAX simulation software.
    You can now configure CIUMon to talk to the TRAX software to get emulated
    data for your system.
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9.  You can now specify the interval at which CIUMon checks for a valid connection
    with the CIU.  This option can be found on the "Configuration" page of the
    CIUMon options.  If you wish to turn the automatic connection check off
    simply enter in an interval of zero.

CIULink:

1.  The sequence of data logging dialogs have been revamped for ease of use.
    You will now be able to specify the type of logging (past, present
    or both), the name of the file to log to and what type of data to
    log from one location.

2.  Live loop entries are no longer allowed after the demo setting has been added.

3.  Some scrolling and display problems have been fixed.

Hyperlink:

1.  Positioning of vertical text on Conductor NT and PPB graphics has been fixed.

2.  The reference index now has links to off-module references.

3.  Hyperlink now generates a zero-length wire where input/output are overlaid to
    make a connection on WinCAD sheets.

4.  A group is now being made for all batch files so that files will be searchable.

5.  More data being read from the MHD file is now being displayed on the CAD sheet.

6.  Function code 229 support has been added.

7.  Spare inputs are now marked when the PCU, Module and Block are all equal to 
zero.

8.  Support for Displaynames.txt which was previously broken has been fixed.

9.  Hyperlink now generates an error message for inappropriate tagatoms that are
    found for Conductor NT or PPB.

10. Additional coordinate information has been added to our live wire message 
    to aid in troubleshooting.

11. DADIG has been added to the alarm tag function code list.

12. Flat function discrepancies (function code 1) have been fixed.

13. Non-exception report tags used on graphics are now reported.

14. Two new lists are now generated by hyperlink:  TREND_ARCHIVE.TXT and 
    TREND_UNUSED.TXT.  Trend tags that are not used on any graphic but have the
    TRUSAGE field set to ARCHIVE are listed in the first list.  Trend tags not
    used on any graphic and have the TRUSAGE field not set to ARCHIVE are listed
    in the second file; hyperlink generates a warning message as well for this
    condition.

15. An error message is no longer generated for Function code 179 when S15 is
    set to zero.

16. General hyperlink performance improvements should result in decreased runtime.
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Decomposer:

1.  Links on CAD sheets by document name have been corrected for Composer projects.

2.  Function code 247 I2 spec handling has been corrected. 

3.  Function code is now mentioned in errror messasges.

DataFiles:

1.  Errfilter.cfg updated for new and existing error messages (trend errors, TSTALM
    block handling, QOR with 0 inputs).

2.  Tagatoms.txt has been updated with new entries.

3.  Corrections made to output.txt.

===================================================================

Previous Version:      DBDOC  -  Release Notes - Version 10.1   Date: September 13, 
2007

Hyperview:

1.  The new Watch Window feature allows you to plot multiple points on the same 
graph.
    The Watch Window is resizeable, rescaleable and printable. Points may be edited,

    added and/or deleted within the Watch Window. You may create multiple Watch 
    Window groups to monitor different sets of points.  Data is plotted in real time
    with leading edge values.  Plots feature a timescale, crosshairs and timestamps.
    Timestamps persist across Hyperview runs. Import CIULink lists into a Watch 
Window
    group from an exported CIULink tag list or from a local registry.  Right click a
    hotspot or an existing Live Loop Annotation to add it to a watch window group.
    Data is collected and logged in .csv files by default and persits across 
Hyperview 
    runs. Data can later be analyzed in Micosoft Excel. You may choose to not log 
    data to a file. Collected data can be selectively deleted.

2.  The Snapshot operation has been modified.  Each time the camera button is 
    pressed, new data will be fetched and displayed.  To turn off the snapshot
    feature, the button now needs to be double-clicked.  Also, if you zoom or change
    drawings while Snapshot mode is on then data will be refetched.

3.  Configurable data persistence and background collection for live loop monitoring
    has been implemented.

4.  You can now show Live Loop Annotation data graphically. These graphs are 
resizeable, 
    rescaleable, scrollable, and you can add timestamps to the graphs. Data persists

    across hyperview runs by default. You may choose to log collected data to a file
or 
    not. Collected data can be selectively deleted.

5.  A button has been added to the toolbar for the creation of Live Loop 
Annotations.

6.  Continuous update live loop annotations are now flagged in the Annotation
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    Manager.

7.  You now have the option to select full sheet printouts where the title, date,
    caption and zoombox are suppressed.  This option can be found in the "Advanced
    Print" options.

8.  For digital states, the symbol has been moved to appear after the logic state
    descriptor.  As well, you can now choose to suppress the logic state labels -
    the "Display Logic States" option is available under the "View" menu.  (5294, 
5301)

9.  Various memory and resource leaks have been fixed.

CIUMon:

1.  Handling for the NCIU01 type of CIU has been corrected.

2.  CIUMon now correctly handles error 105 - Undefined block number. The response
    CIUMon sends back to Hyperview and CIULink will correctly identify the point
    as being in error.

3.  CIUMon has been updated to use CrypKey version 6.120.

CIULink:

1.  Customizable logging options are now available for export view logging.  You
    can choose what data will be written to the log.

2.  A comma-separate variables (.CSV) file allows importation of CIULink data
    into other applications including MicroSoft Excel easily.

3.  CIULink has now been equipped with a new synchronized start/stop feature
    which allows for monitoring and logging to be turned on and off at a specified
    time.

4.  Logging now takes place to either the user specifed filename or to a default
    location - the "DBDOC LOGS" folder in your personal folder which, in most
    cases, is "My Documents".  In the default logging location, the log filename
    will have the date appended to it so that a new file will be generated each
    day.

5.  The CIULink saved settings have been moved from the HKEY_LOCAL_MACHINE
    registry key to HKEY_CURRENT_USER.

6.  This is the first release of the full unicode version of CIULink.

7.  When adding a point that is not found in a database, you can now enter a
    short description to describe it.  This description will be displayed in
    the "Tag" field in Export view.

BuildPlus:

1.  Final version of DBDOC that supports 98/ME is released.

2.  Former "BuildPlus Options" are now applied at the buildroot level and have 
    been so renamed.  This allows you to set the options just for the projects
    in a  specific root rather than to all existing projects.  There are a few
    options that will still apply to all projects and they can be found in the
    new "Global Options".
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3.  You now have the ability to specify the code page value that DBDOC will use
    to interpret your data.

4.  BuildPlus has been updated to use CrypKey version 6.120.

Wizard:

1.  Module 1,00,00 chapters are now sorted alphabetically.

2.  Batch file processing speed has been greatly improved.

Hyperlink:

1.  Conductor NT tag atoms handling has been improved with the implementation of
    tagatoms.txt.

2.  Logical operator support in Conductor NT and Process Portal B has been added.

3.  A new error message now reports TSTALM blocks that test the same attribute of
    the same block.

4.  Tags with spaces in them are now handled properly in Process Portal B Graphics.

5.  Correction has been made to re-implement the display of SODG graphic titles in
    the M14.

6.  Hyperlink now generates a report of all CLD and CAD files with layer 5 used.
    The files Layer_5.txt and CADLAYER.DBF can be found in the Exports folder of
    the project directory.

7.  CLIF Block Spec handling has been corrected.

Decomposer:

1.  Handling for function code 247, specs 30 and 31 has been added.

Database Utilities:

1.  Database records with blank tagnames are now omitted.

2.  Text string support has been added for Conductor NT.  We now get the strings
    for logic states, alarm comments, engineering units descriptor and text
    selection text.

Data Files:

1.  Errfilter.cfg updated for new and existing error messages.

2.  Output.txt modified for function codes 227, 228 and 229.

3.  New file tagatoms.txt has been added to handle Conductor NT tag atoms.

===================================================================

Previous Version:      DBDOC  -  Release Notes - Version 10.0   Date: March 6, 2006

Page 7



DBDOC RELEASE NOTES.TXT
Wizard:

1.  There is now a special override checkbox specifically just for the 
    module header files if you have chosen to build in CAD sheets.  If you
    choose only one MHD to build into your project, you must check the 
    "Single MHD" checkbox before the "Next" button is enabled.
2.  If you choose to build in your error files into the final M14, you
    can now change where the actual chapter of error files appears in 
    the M14.  Turn on the "Show re-order TOC in Wizard" option in the
    "Advanced Options" and in the Wizard, drag-and-drop the error files
    to where you want them to appear in your M14.

BuildPlus:

1.  The printing in the "Management of Change - Print Changes" dialog has been 
    fixed.
2.  The "Graphics-to-Symbols Associations" have been moved into the "Project
    Options".
3.  The database searching in the "Database Specification" dialog has been 
    improved to provide for faster searching when looking for multiple 
    database types.
4.  The "F5" key now refreshes the BuildPlus state (the same as the "Refresh"
    button on the toolbar).
5.  Support to make multiple database-graphics associations for global symbols
    has been added.
6.  You now have the option to copy the final M14 to multiple locations, 
    instead of just a single location, upon the completion of a successful 
    build.  This can be found on the "Processing Options" tab in the "Project 
    Options".
7.  You can now specify different types of return code checks other than just
    "equal to" for the pre- and post-script processing runs.
8.  Handling has been added to support the new DBOPCCSV database utility.
9.  If you encounter the "Sort failure due to error 1" during your 
    MediaView compile and you are building large database files, we may be
    able complete the compile with the databases processing re-ordered.
    In the "Processing Options | Advanced Options" check the "Process
    databases in order of descending number of tags" and try building
    again - it may make the problem go away.
10. If error folder archiving is turned on, the name of the folder will now
    be the same as the M14 file.  When the "Rename .M14 Document" option 
    under the "Tools" menu is used, the associated archived error folder,
    if one exists, will also be renamed to follow that of the M14 file.
11. Microstation drawings (.DGN) are now supported in our Management of 
    Change processing.
12. At startup, BuildPlus will check to see if the dongle and its 
    necessary drivers are present.  If they are not, BuildPlus will
    bring up a warning and give you a chance to install the drivers at
    that time.  If you want to check driver versions or intall/uninstall
    drivers, look under the "Tools" menu and click on the "Check Dongle
    Driver..." option.
13. The log created during a buildall has been moved to the actual
    buildroot in which the buildall is occurring (the old location
    was the Log subfolder of the installation directory).

Hyperlink:

1.  Hyperlink now requires that the DBDOC dongle be present before a build
    can proceed.  If you require a dongle, please contact GMCL to get one
    sent to you.
2.  Output Reference Destinations now are displayed for Composer system local
    output references (references within the same module).
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3.  An index of unlinked graphics is now created to show all graphics that 
    cannot be called by a built-in function from any other graphic.  It shows
    graphics that are orphaned, as well as ones that have been abandoned or never
    implemented.
4.  The adapt block target spec value is reported in the case of adapt blocks that
    are out of sequence.  This allows the user to inspect the messages looking for 
    values that have not been initialized, a possible problem on switching modules.
5.  External output reference does not exist for IREF "xxxx" now lists the loop, 
    PCU, module and block to help you understand where the output reference is 
    needed.
6.  The FC source is now reported for tagged but not exception-reported message to
    make them easier to understand.
7.  PV/SIG:S now gets live loop data.
8.  Conductor NT has problems with trailing space in file name, so we now report all
    graphics files with spaces in the name.  
9.  Lifecycle status is now used in our Conductor NT, Process Portal B and Composer
    processing
10. User fonts are now preserved so diagrams are readable.
11. Logical OR operator support has been implemented.
12. Initial support for Conductor 5.0 has been added.
13. PPB and OPC tags are now supported in DBDOC.
14. We have corrected handling of Spec 4 for Function Code 242.
15. The capability to view the following function codes as a dynamic bar
    has been added:  21, 22, 23, 27, 28, 30, 47, 70, 79, 80, 132,
    158, 182, 216 and 222.
16. If building graphics, the "Unused on Primary Display" error message
    now actually cites the primary display name.
17. When building Conductor NT and/or PPB graphics, if you forget to
    specify a colordef.dat and/or a fontdef.dat file, we will now use 
    some default color and font data so that your graphics will at least
    appear in your M14.
18. FDF file formats are now supported.
19. Blocks imported from external sources that we report as "No Source
    Config" are now tagged with the phrase "Unconfigured source".  
    Search for this phrase in your M14 in Hyperview and you will be 
    presented with list of all of your unconfigured blocks.
20. In Composer systems, if an OREF does not exist, we will now tag
    the source with the phrase "No OREF". Searching for the phrase 
    "No OREF" shows every place in your system where an output
    reference is needed.

Taglist_exporter:

1.  DAANG Blocks now have HALRM handled correctly.  This corrects a problem
    that affected people using the DBDOC tag export for PI systems.

Hyperview:

1.  The feature "Go To Output" has been implemented.  After you have used the
    "Go To Source" feature, you can then double-click on the source or select
    "Go To Output" from the pop-up menu to return to the block that you just
    came from.
2.  A fix has gone in to correct the printing done by "Management of Change" 
    from the BuildPlus window.
3.  The size of the text that appears in annotations can now be changed to
    suit your needs.
4.  You may now modify the color of your text and live loop annotations, as
    well as any manual live loop boxes that you spawn.
5.  In the pop-up menu, you now have the option to set the zoom percentage
    that you want the drawing to be zoomed to.  Minimum and maximum zoom
    factors are taken into consideration so that you cannot zoom outside of 
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    bounds.
6.  If you have a mouse that has a scroll wheel, you can now use it in 
    conjunction with the "CTRL" key on your keyboard to scroll pages left and
    right.
7.  In a multi-IP Address and/or multi-loop live monitoring setup, Hyperview
    will now do some checking to automatically detect which connections are
    active.  The Hyperview user will not have to know which live loop setups
    work as Hyperview will automatically detect it for him.
8.  Specs are now displayed in their own stand-alone windows which can be
    moved to different locations on your sheets if they are obscuring other
    information that you want to see.   The windows are rubberbanded to
    their original spots so that you can see where they originated from.
9.  There is a new interface to manage both text and live loop annotations.
    Previously, live loop annotations could not be found unless they were
    bookmarked; now you can easily find them in our "Manage Annotations"
    tool.
10. Handling has been added for the case where multiple Hyperviews are 
    viewing the same M14 file - text and live loop annnotations,
    bookmarks, etc. can now be added in any copy of Hyperview without
    wiping out additions in the other open copies.
11. When viewing an analog value as a dynamic bar, the actual value will
    be shown in a tooltip if you put your mouse on the bar.
12. The Hyperview "red boxes" problem has been fixed - this is where
    Hyperview would display red boxes even though it appeared the CIUMon
    communications were good.  The only way to fix this previously was
    to close down Hyperview and restart it.  We have added in handling
    which should take care of this problem and allow for the live data
    to be displayed without closing and restarting.
13. You can now print just the FC 1 graph in Hyperview without the 
    underlying CAD behind it.  The graph will be printed at full-page 
    size.
14. All FC 1 graphs on a sheet can be opened at one time by selecting
    the "Graph | All Functions..." from the pop-up menu.
15. Live loop annotations can be displayed as bar graphs.
16. The "Go to Source" feature has been improved.

Decomposer:

1.  Error messages have been improved to provide more information, such as
    loop, PCU, Module and Block, so that it is easier for you to track down
    potential problems.
2.  Chinese characters are now replaced by a "?".
3.  Our Composer processing now looks at the Lifecycle status and handles tags
    appropriately based on the data from this field.
4.  Source and destination document names have been added to off-module
    connections.
5.  Function codes 22, 23 and 201 are now being handled correctly.

Database Utilities:

1.  DBFMT has been modified so that trailing spaces are compressed in our
    database presentation.
2.  DBOPCCSV.exe has been created to handle .CSV files that are extracted from
    OPC-90.  These files can now be built into your final M14 by looking for
    and selecting them in your "Database Specification" search in BuildPlus.
3.  DBXML.exe has been upgraded.  It now relies on the file libexpat.dll.

CIULink:

1.  Create an export file that allows you to import the tags being monitored in
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    CIULink on one machine onto a different computer.
2.  CIUlink can now automatically generate a file which can be imported into
    Microsoft Excel to set up live data monitoring via DDE.
3.  The tagname is now recorded in the log created when monitoring in Export view.
4.  Horizontal scrolling has been fixed in the Debug view.

CIUMon:

1.  CIUMon keeps track of the incoming requests and compresses them so that 
    duplicate requests are not sent out to the CIU, thus reducing the load.  
    CIUMon will send out the information to all those who requested the data 
    when it receives a response back from the CIU.
2.  The "F1" key now launches the help file.
3.  Spec formatting for the Harmony I/O Function codes (FC 221 to 229) has
    been corrected.
4.  Handling for the NCIU01 type of CIU has been added.
5.  Changes have gone in to the correct the reporting of IP fragments by some
    firewalls.  We now correctly handle the sending of the UDP packets between
    CIUMon and Hyperview/CIULink.
6.  The viewing of tracked user statistics has been improved.  On both the 
    detailed and summary dialogs there will an "Update" button which will allow
    you to get the most current statistics without having to close down 
    and reopen the dialog.  As well, you can switch between the two views
    easily with the "Switch to Details (Summary)" button that has been added.
7.  The requestor's IP Address is now appended to the end of the response
    message being sent out by CIUMon so that the user knows where each set of
    data is going.
8.  A new program, CIUMonController, has been created to allow the user
    to change particular options (such as turning on logging) in service
    copies of CIUMon.  This is particulary useful when a CIUMon service is
    not interacting with the desktop.
9.  Handling has been added to work with the Hyperview automatic live loop
    connection detection.
10. CIUMon has had a significant "memory leak" fixed.  The effect was to use
    a lot of virtual memory when CIUMon ran for weeks, which only was recovered
    when CIUMon was stopped or the computer rebooted.

Virtual Port Setup:

1.  A new version of the VSP files has been implemented to take advantage of
    the new features and fixes.  Upon the initial running of VirtualPortSetup
    with these new files in place, you will be asked to reboot your machine in
    order for the files and registry to be completely updated.
2.  You will now be allowed to create more than 9 VSPs on your machine and
    create up to 15 virtual connections.  The port numbers that will be available
    range from COM1 through to COM128.
3.  The "Physical-to-Virtual Connections" option has been disabled until we can
    do more research into how these connections work.    

Data Files:

1.  Errfilter.cfg has been modified to handle new error messages generated by
    hyperlink.
2.  Filetypes.txt and Param.txt have been improved.
3.  Output.txt has been corrected for its descriptions for Function code 149.
4.  Bitmaps are now included in the search for PPB/Operate IT/Conductor NT
    submodels and will be built if any are found.
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